DIGITAL VOICE
RECORDER

DS-3400
INSTRUCTIONS

Thank you for purchasing an Olympus
Digital Voice Recorder.
Please read these instructions for information
about using the product correctly and safely.
Keep the instructions handy for future reference.
To ensure successful recordings, we recommend that
you test the record function and volume before use.

EN

Introduction
Introduction
● The contents of this document may be changed in the future without advanced notice.
Contact our Customer Support Center for the latest information relating to product names
and model numbers.
● The utmost care has been taken to ensure the integrity of the contents of this document. In
the unlikely event that a questionable item, error, or omission is found, please contact our
Customer Support Center.
● Any liability for passive damages or damage of any kind occurred due to data loss incurred
by a defect of the product, repair performed by the third party other than Olympus or an
Olympus authorized service station, or any other reasons is excluded from Olympus’s
liability.
Trademarks
Microsoft and Windows are registered trademarks of Microsoft Corporation.
Macintosh is a trademark of Apple Inc.
Intel and Pentium are registered trademarks of Intel Corporation.
The SD logo is a trademark.
The SDHC logo is a trademark.
Other product and brand names mentioned herein may be the trademarks or registered
trademarks of their respective owners.
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Safe and Proper
Usage
Before using your new recorder, read
this manual carefully to ensure that you
know how to operate it safely and
correctly. Keep this manual in an easily
accessible location for future reference.
• The warning symbols indicate important
safety related information. To protect
yourself and others from personal injury
or damage to property, it is essential that
you always read the warnings and
information provided.

Convention Used In this Manual
• The word “card” is used to refer to the SD
card.
• The word “DSS Player” is used to refer to
the DSS Player Pro Dictation Module in
Windows environment and DSS Player in
Apple Macintosh environment.
• The Notes at the bottom of a page are
used for additional information,
exceptions, or related events.
• Words in uppercase form such as PLAY
or REC are used to describe a function
or button on the recorder.

General Precautions
● Do not leave the recorder in hot, humid
locations such as inside a closed
automobile under direct sunlight or on the
beach in the summer.
● Do not store the recorder in places exposed
to excessive moisture or dust.
● Do not use organic solvents such as
alcohol and lacquer thinner to clean the
unit.
● Do not place the recorder on top of or near
electric appliances such as TVs or
refrigerators.
● Avoid recording or playing back near
cellular phones or other wireless
equipment, as they may cause interference
and noise. If you experience noise, move
to another place, or move the recorder
further away from such equipment.
● Avoid sand or dirt. These can cause
irreparable damage.
● Avoid strong vibrations or shocks.
● Do not disassemble, repair or modify the
unit yourself.
● Do not operate the unit while operating a
vehicle (such as a bicycle, motorcycle, or
go-cart).
● Keep the unit out of the reach of children.
<Warning regarding data loss>
Recorded content in memory may be
destroyed or erased by operating mistakes,
unit malfunction, or during repair work.
It is recommended to back up and save
important content to other media such as a
computer hard disk.

5

General Precautions
Batteries
Danger
• Do not solder lead wires or terminals directly
onto a battery or modify it.
• Do not connect the = and - terminals
together. This may cause fire, overheating or
electric shock.
• When carrying or storing the battery, be sure
to put it in the provided case to protect its
terminals. Do not carry or store the battery
with any metal objects (such as key rings).
If this warning is not followed, fire,
overheating or electric shock may occur.
• Do not connect the batteries directly to a
power outlet or a cigarette lighter of an
automobile.
• Do not insert the batteries with their = and
- terminals reversed.
• If any liquid from a battery gets into your
eyes, promptly wash it off with clean water
and consult your doctor at once.
• There is a hole from which gas escapes on
the = terminal. Do not cover or block it.

Warning
• Batteries should never be exposed to flame,
heated, short-circuited or disassembled.
• Do not attempt to recharge alkaline, lithium
or any other non-rechargeable batteries.
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• Never use any battery with a torn or cracked
outer cover.
• Keep batteries out of the reach of children.
• If you notice anything unusual when using
this product such as abnormal noise, heat,
smoke, or a burning odor:
1 remove the batteries immediately while
being careful not to burn yourself, and;
2 call your dealer or local Olympus
representative for service.
• Do not expose the batteries to water. Do not
allow water to contact the terminals.
• Do not remove or damage the battery
insulating sheet.
• Do not use the batteries if you find
something wrong with them such as leakage,
color change or deformity.
• Should any battery liquid get on skin or
clothing, promptly wash it off with clean
water.
• Keep batteries away from fire.

Caution
• Do not subject batteries to strong shocks.
• Do not use batteries of different types,
voltages, and/or brand names.

1 Getting Started
Main Features
● Support type of memory: SD card (☞ P.8).
● Three Programmable smart buttons F1, F2 and F3 (☞ P.58).
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● Recording and storing voice in Digital Speech Standard Pro (DS2 format).
● Data encryption function for securing recordings on the device.
● Overwrite Recording and Insert Recording (partial insertion) available (☞ P.21, 22).
● Supports USB 2.0. High-Speed, which enables high-speed data transmission from the recorder
to your computer.

Main Features

● Two recording modes, QP (Quality Playback) mode or SP (Standard Playback) mode (☞ P.24).

● Five folders and up to 200 files/folder, for a maximum of 1000 recordings (☞ P.19).
When using DSS Player, it is possible to create up to a maximum of seven folders (1,400 files) (☞ P.58, 59).

● It has a built-in Variable Control Voice Actuator (VCVA) function (☞ P.25).
● Large LCD screen with backlight.
● Device Lock function to prevent unauthorized access to device (☞ P.58).
Authentication system via password (☞ P.38, 39).

● Index mark function which is useful to search particular points in the dictation (☞ P.47).
● Verbal comment function which allows transcriptionists to instantly search and play back
instructions on their computer (☞ P.46).
● Priority Setting (☞ P.42).
● DSS Player software included (☞ P.59).
It is possible to customize the recorder in a number of ways.
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Memory Card
This recorder uses memory in the form of SD
card memory.

Compatible Cards
The recorder supports cards with memory
capacity between 512 MB to 16 GB.

1
Memory Card

Settings and operating environment
relating to the card
Check the latest operating information on the
Olympus homepage (http://www.olympus.com)
when using cards other than the included card.
In addition, refer to the following pages as well
when handling the card.
• Inserting and Ejecting a SD card (☞ P.16)
• Formatting the Card (Format) (☞ P.54)

SD card
1 Card Lock
SD card is equipped with a lock function.
When the lock function is used, important
data is protected by preventing it from being
accidentally overwritten or erased.
When the lock function is set will appear
on the display.
2 Index Area
For writing down information identifying card
or content.
3 Contact Area
Comes into contact with the recorder’s
signal read contacts.

Memory Sizes of Cards and
Approximate Recording Times*1
Memory Size

SD card
1

3

2

QP Mode

512MB

38 hr. 30 min.

1GB

77 hr. 00 min.

SP Mode
79 hr. 00 min.
157 hr. 50 min.* 2
2

312 hr. 20 min.*2

2GB

152 hr. 30 min. *

4GB

305 hr. 50 min.* 2

8GB

624 hr. 30 min.*2 1279 hr. 30 min.*2

16GB

1248 hr. 10 min.* 2 2557 hr. 10 min.*2

626 hr. 50 min.* 2

The above are the standard times, and the available
recording time will vary depending on the card.
*1: Available recording time for one continuous file.
Available recording time may be shorter if many short
recordings are made.
*2:Total recording time of several files. The maximum
recording time per file is 99 hours 59 minutes.
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Memory Card
Warning

Notes

• Do not touch the card contacts.
That may damage the card.
• Do not place the card in locations
with static electricity.

Check Card Information (Card Info.)
Information such as the memory capacity and
remaining memory for installed cards can be
displayed on the recorder (☞ P.34).
Card Info.
SD
Remain
Capacity

BACK

1
Memory Card

• Store the card in a location that is
out of the reach of children. In
case of accidental ingestion,
consult a physician immediately.

• When initializing (formatting) a card, confirm that
no necessary data is stored on the memory card
beforehand. Initialization completely erases the
existing data on the card.
• In some cases cards which have been formatted
(initialized) by another device, such as a computer,
cannot be recognized. Be sure to format them with this
recorder before using.
• The card has a service life. When reaching the end of
its life, writing or erasing data on the card will be
disabled. In this case, replace the card.
• If you use a PC card adapter compatible with the card
to save or delete some data on the card, the maximum
recording time on the card may be decreased. To
recover the original recording time, initialize/format the
card in the recorder.
• Olympus will not be held liable for any data corruption
or loss due to misuse of the media card.

540MB
1.0GB

EXIT
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Identification of Parts
0
!
@

1

1
2
3

#

Identification of Parts

4
5

&

$
%
^

*
(
)

1 SD card slot
2 Built-in microphone
3 NEW button
4 REC button
5 REW button
6 FF button
7 STOP button
8 POWER/HOLD switch
9 ERASE button
0 EAR (Earphone) jack
! MIC (Microphone) jack
@ Record indicator light
# Display (LCD panel)

10

w
-

6
7

8

q =

9

$ + (Volume) button
% Fast Forward (9) button
^ PLAY/OK button
& Programmable smart button (F1,
F2, F3)
* Rewind (0) button
( - (Volume) button
) Built-in speaker
- Battery cover
= PC (USB) terminal
q Cradle connector
w Battery cover release button

Identification of Parts
Display Status Indicators
7
1

QP DICT VCVA
DS3400

QP DICT
DS3400

E

025 / 030
F

00 M 10 S
15 H 22 M 30S
VERBAL

DISPLY

INDEX

025 / 030
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!
0 @
#
$

Display in the recording
mode

1 Record mode indicator
2 Current folder
3 Memory remaining indicator
(E/F bar)
4 Record indicator
5 Remaining recording time
6 Level meter indicator
7 Microphone sensitivity indicator
8 Current file number
9 Total number of files in the folder

Author ID indicator
Battery indicator
VCVA VCVA (Variable Control Voice
Actuator) indicator

02 M 50 S
12M 05S
INSERT

SPEED

INDEX

1

/ 030
F

%

49 S

^

9 M 57S
Y

INDEX

Display in the playback
mode

Identification of Parts

2
3
4
5
6

8

0 Recording elapsed time
! Playback position bar indicator
@ Play indicator
# Total recording time of the
selected file
$ Button guide display
% Current Playback time
^ Main Button Guide
You can display the Main Button Guide by
using “Main Button Guide” (P.58) of the
customize functions of DSS Player.

Pending indicator
Card Lock indicator
Encryption indicator
Priority indicator
Erase Lock indicator
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Installing Batteries
This recorder can be used with AAA Alkaline
Batteries.

1
1

Lightly press down on the battery cover
release button, then open the battery
cover.

Recharging Battery Pack
The battery indicator on the display changes
as the batteries lose power.
→

→

Installing Batteries

When
appears on the display, replace the
batteries as soon as possible.
When the batteries are too weak, the recorder
shuts down and [
Battery Low ] appears
on the display.

Cautions Concerning the Battery
Warning

2

Insert two AAA batteries, observing the
correct polarity as shown in the
illustration below, then close the battery
cover.

• Using batteries for which part or all
of the external coating (insulating
sheath) is peeling off or batteries
which have ruptured may cause fluid
leaks, overheating, and explosions.
For this reason such batteries should
absolutely not be used.
• Commercially available batteries for
which part or all of the external
coating (insulation sheath) has been
peeled off should absolutely not be
used.

Unusable batteries

Insert the batteries in the direction inscribed on
the inside of the recorder’s battery compartment.
In addition, when inserting the batteries, insert
them so that the tape is under the batteries, as
shown in the illustration. The batteries can then
be removed easily by pulling up the tape. When
pulling on the tape the batteries may suddenly
pop out, so be sure to press down lightly on
the batteries with your finger while pulling.
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Batteries for which the entire external coating
(insulating sheath) is peeled off (naked batteries),
or those where it has partially been peeled off.

Installing Batteries
Notes

1
Installing Batteries

• Be sure to turn OFF the recorder before replacing
the batteries. Removing the batteries while the recorder
is in use may corrupt the card. If you are recording into
a file and the batteries run out, you will lose your
currently recorded file since the file header will not be
written. It is crucial to replace the batteries when one
hash mark is shown in the battery icon.
• Be sure to replace both batteries at the same time.
• Never mix old and new batteries, or batteries of
different types and/or brands.
• If it takes longer than 1 minute to replace dead batteries,
you may have to reset the time when you load new
batteries.
• Remove the batteries if you are not going to use the
recorder for an extended period of time.
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Power Supply
When the recorder is not being used, turn the
power off to reduce battery consumption to a
minimum. Even if the power is turned off, existing
data, mode settings, and clock settings will be
maintained.

1

Turning On the Power

Power Supply/Power Save Mode

While the recorder’s power is off, slide the
POWER/HOLD switch in the direction
indicated by the arrow.
The display will turn on, and after [System Check]
appears, the power will be turned on. The resume
function will bring the recorder back to the stop
position in memory before power was turned off.

Turning Off the Power
Slide the POWER/HOLD switch in the
direction indicated by the arrow for 0.5
seconds or longer.
The display shuts off and the power will be turned
off. The resume function remembers the stop position
before the power is turned off.

Power Save Mode
(Power Save)
When the recorder is ON but not in use for 10
minutes, by default, it will switch to power save
mode automatically. To reactivate the recorder
again, operate any button or the slide switch.

Power Save Setting
You can set the time to enter Power Save
mode from among [5 minutes. ], [10
minutes.], [30 minutes.], [1 hour], and [Off].
To exit power save, press any button.
The [Power Save] setting can be changed
from the Menu. For more details, refer to
“Menu List” (☞ P.33) and “Learning to Use
the Menu” (☞ P.35).
Power Save
5 minutes
10 minutes
30 minutes
1 hour
Off
BACK
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EXIT

HOLD
If you bring the POWER/HOLD switch to the
HOLD position, the current conditions will be
preserved, and all buttons and switches will be
disabled.This feature is useful when the recorder
has to be carried in a bag or pocket.

Set the recorder to HOLD mode

HOLD

Slide the POWER/HOLD switch to the
HOLD position.

1

After [Hold] appears on the display, the recorder is
set to HOLD mode.

Exit HOLD mode
Slide the POWER/HOLD switch to the A
position.
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Inserting and Ejecting a SD card
Inserting a SD card
Insert the SD card into the card slot in the
direction shown in the illustration until it
clicks.

1
Inserting and Ejecting a SD card

When inserting SD card into the SD card slot,
the recorder message [Please Wait] will flash
on the LCD display for a few seconds while
validating the SD card.

Ejecting a SD card
Push the SD card inward once to unlock it,
and let it eject.
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Notes
• Insert the card keeping it straight.
• The card stops with a click when it is inserted all
the way.
• Inserting the card the wrong way or at an angle
could damage the contact area or cause the card
to jam.
• If the card is not inserted all the way, data may not
be written to the card.
• Hold the card straight and pull it out.
• If an unformatted card is installed, the recorder will
automatically display the menu format option (☞ P.54).
• Never use any card in the recorder unless it has been
formatted on this unit (☞ P.54).
• Never remove the card while the recorder is in
operation. This may damage the data.
• Releasing your finger quickly after pushing the card
inward may cause it to eject forcefully out of the slot.

Setting Time and Date (Time & Date)
Setting the correct time and date on the recorder
is very important since every file recorded on the
recorder will have the time and date information
as part of the file header. This will simplify the
file management aspects later on.

Press the 9 or 0 button to select
the item to set.
Select the item from “hour”, “minute”, “year”,
“month” and “day” with a flashing point.
Time & Date

3 M 15 D 2009 Y
5: 00 PM
BACK

2

24H

Press the

EXIT

+ or – button to set.

Follow the same steps by pressing the 9 or
0 button to select the next item, and press
the + or – button to set.
Time & Date

1
Setting Time and Date

The hour indicator will flash automatically
when you load batteries before using the
recorder for the first time, or after the
recorder has not been used for a long time.
However, when a Password has been set
as the device lock function (☞P.38), the
recorder will go to the time and date set
screen after verification (unlocking).

1

3 M 15 D 2009 Y
5 : 45 PM
F1, F2, F3 button

PLAY/OK

PLAY/OK,+ ,
9, 0
button

BACK

24H

EXIT

–,
• You can choose between 12 and 24 hour
display by pressing the F2(24H or 12H)* button
while setting the hour and minute.
Example: 5:45 P.M.
5:45 PM (Initial setting)←→ 17:45
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Setting Time and Date (Time & Date)
• You can choose the order of the year, month,
day by pressing the F2(D/M/Y or Y/M/D or M/
D/Y)* button while setting them.
Example: March 15, 2009
(Initial setting)

1

3M 15D 2009Y
15D 3M 2009Y

Setting Time and Date

2009Y 3M 15D

Changing the Time and Date
When the recorder’s POWER/HOLD switch is
turned ON the [Time & Date] will be displayed
for two seconds. If the time and date is not
correct, set it using the procedure below.

1

See P.34 regarding the menu.
Device Menu

*The display will vary depending on the status of the
settings.

3

Beep
Cue/Rev Sound
Power Save
Time & Date
USB Class
Reset Settings

Press the PLAY/OK button to complete
the setup screen.
The clock will start from the set date and time.
Press the PLAY/OK button according to the time
signal.

BACK

• You can set the time and date from your PC using DSS
Player software (☞ P.59).

EXIT

2

Press the PLAY/OK or 9 button.

3

Press the F3(EXIT ) or 0 button to
complete the setting.

Notes
• If you press the STOP button during the setup operation,
the settings are cancelled, and the recorder returns to the
previous screen.
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Press the + or – button in the [Device
Menu] screen, then select [Time & Date].

The time and date screen appears. The hour
indicator flashes, indicating the start of the time
and date setup process.The following steps are
the same as Step 1 through Step 3 of “Setting
Time and Date (Time & Date)” (☞ P.17).

2 Basic Operations
Recording

Record Function

Recording Related Settings
Recording related settings can be
configured to provide a suitable recording
environment.
• Microphone Sensitivity (Mic Sense)
(☞ P.23)
• Recording Modes (Rec Mode) (☞ P.24)
• Using the Variable Control Voice Actuator
(VCVA) (☞ P.25)
• Recording Monitor (☞ P.26)
• Verbal Comment (☞ P.46)
• Pending Files (Pending) (☞ P.41)

2
Recording

The recorder has five folders, A, B, C, D, E
and you can select folder by pressing the
F1(FOLDER) button. These five folders can
be selectively used to distinguish the kind
of recording; for example, Folder A might
be used to store private information, while
Folder B might be dedicated to holding
business information. Up to 200 messages
can be recorded per folder.
By default, the Recording Mode is QP.

By default, the RECORD function is configured
to record at the current position (overwrite).
However, that can be changed to any of the
following settings:
• Append: Appends the recording to the end of the
current file (☞ P.20).
• Overwrite: Overwrites the recording starting at the
current position in the file (☞ P.21).
• Insert: Inserts the recording at the current position
in the file (☞ P.22).
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Recording
New Recording

1

Create a new file to record in.

1
2

Press the NEW button to create a new
file.
aSelected Author ID
bNew file number
cRemaining recording time

2

a
b

QP DICT
DS3400

031 / 030

E

F

New File
Remain

15 H 22 M 40 s

c

FOLDER PRIOR

Recording

2

2

3

Press the REC button to start
recording.
The record indicator light glows orange and
(Record indicator) appears on the
display.
Aim the microphone at the sound source.
When you press the F2 (DISPLY) button
during recording, you can change the LCD
screen displays.

MENU

QP DICT
DS3400

d

E

031 / 031
F

00 M 10 s
15 H 22 M 30 s
VERBAL DISPLY

INDEX

dRecord indicator

3

Press the STOP button to stop
recording.
If you want to append additional recordings to
the same file, press the REC button again.

QP DICT
DS3400

031 / 031
02 M 20 s
15 H 02 M 20 s
FOLDER PRIOR

MENU

Notes
• A beep will sound when the remaining recording time reaches 60 seconds, 30
seconds, and 10 seconds while recording.
• When remaining recording time is less than 60 seconds, the record indicator light
starts flashing in orange. When the recording time is decreasing to 30 or 10 seconds,
the light flashes faster.
• [Memory Full] or [Folder Full] will be displayed when the memory or folder capacity
is full.
- Delete any unnecessary files before recording any further (☞ P.29) or transfer
dictation files to your computer using DSS Player Software (☞ P.59).
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Recording
Overwrite Recording

2
2

You can overwrite a previously recorded file from any point within
the file.
Note that the overwritten recordings will be erased.
Select and play the file you want to
overwrite.

2

Press the REC
overwriting.

3

button to start

The record indicator light glows orange and
(Record indicator) appears on the
display.
aRecording elapsed time
bTotal recording time of the selected file

3

2

Stop playback at the starting point of overwrite.
QP DICT
DS3400
E

a
b

101 / 133
F

10 M 25 s

Recording

1

00H 14 M 00 s
VERBAL DISPLY

INDEX

Press the STOP button to stop
overwriting.

Note
• You cannot select a different recording mode (QP, SP) than that of the original file
before overwrite recording.

21

Recording
Insert Recording

1

Additional recording can be inserted into previously recorded file.

PLAY/OK

2

2

1
2

Select and play the file you want to
insert an additional recording into.

Recording

While playing the file, press the
F1 ( INSERT ) button to insert an
additional recording.

QP DICT VCVA
DS3400

134 / 134

[Insert Rec?] appears on the display.

PLAY/OK

00 H 00 M 10 s
33 M 25s

3

Insert Rec?
EXIT

3

3
4

4

Press the REC button to start inserting
an additional recording.
The record indicator light glows orange and
(Record indicator) appears on the
display.
[Insert Rec] and the remaining recording time will
alternate on the display.

Press the STOP button to stop
inserting the additional recording.

QP DICT
DS3400

134 / 134
F

E

00 M 12s
Insert Rec
VERBAL

DISPLY

INDEX

QP DICT
DS3400
E

134 / 134
F

00 M 13s
4 H 33 M 06 S
VERBAL

DISPLY

INDEX

Notes
• The recording time and date of the file is updated to the time and date of the
inserted recording.
• You cannot select a different recording mode (QP, SP) than that of the original file
before inserting.
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Microphone Sensitivity (Mic Sense)
You can switch between two microphone
sensitivities to meet recording needs:
[Dictation] for oral dictation and [Conference]
which is suited for situations like meetings and
conferences with a small number of people.
The setting status will appear on the display
as CONF or DICT .

2

Press the + or – button to select
[Conference] or [Dictation].
Conference...High-sensitivity mode that records
sounds in all directions.
Dictation...Low-sensitivity mode suited for
dictation.
Mic Sense
Conference
Dictation

2

PLAY/OK,+, –,
9, 0 button

PLAY/OK

1

BACK

3

Select [Mic Sense] at the [Record Menu]
screen, then press the PLAY/OK or 9
button.

BACK

Press the PLAY/OK button to complete
the setup screen.
[Conference Set] or [Dictation Set] will light up
on the display, and it will return to the [Record
Menu] screen.
If you press the 0 or F1( BACK) button the
setting will be cancelled and it will return to the
[Record Menu].
Pressing the F3(EXIT) button will cancel the
contents being set and take you out of the MENU.
Mic Sense
Conference
Dictation
Dictation
Set

Refer to P.33 regarding each menu item settings.
Record Menu
Rec Mode
Mic Sense
VCVA
12

EXIT

BACK

EXIT

Microphone Sensitivity

F1, F3 button

4

EXIT

Press the F3 (EXIT ) or 0 button to
complete the setting.
QP DICT
DS3400
E

025 / 030
New File02 M

10 s

3 H 08 M 05s
FOLDER PRIOR

MENU
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Recording Modes (Rec Mode)
The recording mode can choose between QP
(Quality Playback) and SP (Standard
Playback).

Press the PLAY/OK button to complete the
setup screen.

3

[QP Set] or [SP Set] will light up on the display,
and it will return to the [Record Menu] screen.
If you press the 0 or F1(BACK) button the
setting will be cancelled and it will return to the
[Record Menu].
Pressing the F3(EXIT) button will cancel the
contents being set and take you out of the MENU.

F1, F3 button

2
Recording Modes

Rec Mode
QP
SP

PLAY/OK,+ , – ,
9, 0 button

PLAY/OK

SP
Set

BACK

1

Select [Rec Mode] at the [Record Menu]
screen, then press the PLAY/OK or 9
button.

EXIT

Press the F3(EXIT ) or 0 button to
complete the setting.

4

Set Recording Mode is displayed when creating
the New File and during recording.
The recording mode of file recording is displayed
during playback and in stop mode.

Refer to P.33 regarding each menu item settings.

SP DICT
DS3400

Record Menu
Rec Mode
Mic Sense
VCVA
12

E

031 / 030
F

New File
Remain

15 H 22 M 40 s
BACK

2

Press the
or [SP].

EXIT

+ or – button to select [QP]
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PRIOR

MENU

Note
• Choose QP mode for recording meetings or lectures
with crisp clarity.

Rec Mode
QP
SP

BACK

FOLDER

• You cannot select the QP mode when setting the
recorder to the DSS Classic mode.
For details, see “Recording” in the “Customizing the
Recorder” (☞P.58).
EXIT

Using the Variable Control Voice Actuator (VCVA)
Press the REC button to start recording.

2

When the sound volume is lower than the preset
actuation sound level, recording automatically
stops after 1 second approximately, and “Stand
by” flashes on the display. The record indicator
light glows orange and
(Record indicator)
appears when recording starts and flashes when
recording pauses.
QP DICT VCVA
DS3400

2

134 /134

E

F

1 H 25 M 01 s
Standby
VERBAL DISPLY

REC
button

INDEX

Adjust the Start/Stop Actuation Level
While the recorder is in recording mode,
press the 9 or 0 button to adjust the
actuation level.

PLAY/OK

9, 0 button

The VCVA level can be set to any of 15 different
values. The higher the value is, the more sensitive
the recorder can react to sounds. At the highest value,
even the faintest sound will activate recording.
The VCVA actuation level can be adjusted according
to the ambient (background) noise.
QP DICT VCVA
DS3400

134 /134

E

F

1 H 25 M 02 s

1

VCVA Level 05

Set the VCVA in the menu to [On].
Refer to P.33 regarding each menu item settings.

VERBAL DISPLY

a

b

INDEX

a Start level
(Varies according to
the sound volume
being recorded)

Using the Variable Control Voice Actuator

The Variable Control Voice Actuator (VCVA)
is a function that starts recording automatically
when the microphone senses that sounds have
reached a preset threshold volume level, and
automatically pauses when the volume drops
below the threshold. The VCVA feature allows
you to conserve memory by automatically
stopping recording in instances like long silent
periods during meetings.
When this is enabled, VCVA will appear on the
display.

b Level meter
indicator (moves to the
left/right according to
the set level)

Notes
• The start/stop actuation level also varies depending on
the selected microphone sensitivity mode (☞P.23).
• To ensure successful recordings, prior testing and
adjustment of the start/stop actuation level is
recommended.
• If the recorder detects an input that exceeds the Start
level, the dotted line of the Level meter indicator will
change to the full line, and the recorder starts recording.
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Recording Monitor
It is possible to monitor your recording by
listening to the recording while recording is in
progress. Insert the earphone plug into the
earphone jack and use the + or – button to
control the volume level.

2
Recording Monitor

+/–

(Volume)
button

Note
• Insert the plugs in to the end as shown in the illustration
when inserting the earphone or external microphone.
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Playing
You can start playing a file at any point.

1
PLAY/OK

1

Select the file, then press the PLAY/
OK button to start playback.
The
(Play indicator) appears on the
display.
aPlay indicator

2

101 / 133
a

00 M 05 s
27 M 58s
INSERT

3

Press the
volume.

+ or – button to adjust the

The display shows the volume level. You can
choose between 00 to 30.
bVolume level

INDEX

QP DICT
DS3400

101 / 133
b

00 M 07 s

2

Volume 15
INSERT

3

SPEED

Playing

2

PLAY/OK

QP DICT
DS3400

SPEED

INDEX

Press the STOP button at any point
you want to stop the playback.
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Playing
Playback
functions

2
Playing

Fast
Forward
(FF)
Rewind
(REW)
Cue
(CUE)
Review
(REV)
Playback
Speed

Operation

How to Cancel

Press the 9 or FF button once while stopped.

Press the PLAY/OK or STOP
button.

Press the 0 or REW button once while stopped.

Press the PLAY/OK or STOP
button.
Release the button.

Press and Hold the 9 or FF button while stopped
or playing a file.
Press and Hold the 0 or REW button while stopped Release the button.
or playing a file.
Press the F2 (SPEED) button during playback.
➥ Every time the F2(SPEED) button is pressed, the
playback speed will switch.
Play(playback): Playback at normal speed.
Slow Play (slow playback): Playback speed
slows down (-50%), and “Slow play” will turn on.
Fast Play (fast playback): Playback speed
becomes faster (+50%), and “Fast play” will turn on.

Notes
• If you press the 9 or FF button once while fast-forwarding or twice while stopped, the recorder will stop at the end of
the file (F.Skip).
• If you press the 0 or REW button once while rewinding or twice while stopped, the recorder will stop at the beginning
of the file (B.Skip). If the 0 or REW button is pressed within 2 seconds, the recorder skips to the beginning of the
previous file.
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Erasing
Erasing a File
PLAY/OK

2
3

Erasing or deleting a file from any of the folder on the recorder is a
very simple process.

1
2

Select the file you want to erase.
Press the ERASE button.

QP DICT
DS3400

029 / 031

PLAY/OK

4
PLAY/OK

EXIT

3
4

+

Press the
button to select [File
Erase], then press the PLAY/OK
button.

+

Press the
button to select [Start],
then press the PLAY/OK button.
The display changes to [File Erase !] and
erasing will start.

[Erase Done] is displayed when the file is
erased. File numbers will be reassigned
automatically.

2
Erasing

All Erase
File Erase
Cancel

All Erase
File Erase
Cancel
EXIT

QP DICT
DS3400

029 / 031
File Erase
Start
Cancel
BACK

File Erase !

QP DICT
DS3400

029 / 030
Erase Done

Notes
• An erased file cannot be restored.
• Files cannot be erased in the following cases.
- File being set [Lock] (☞ P.40).
- The SD card lock is turned on (☞ P.8).
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Erasing
Erasing All Files in a Folder
PLAY/OK

2

2

All files in a folder can be erased simultaneously.

3

1
2

Select the folder you want to erase.
Press the ERASE button.

QP DICT
DS3400

029 / 030

PLAY/OK

Erasing

All Erase
File Erase
Cancel

4
PLAY/OK

3
4

+

Press the
button to select [All
Erase], then press the PLAY/OK
button.

+

Press the
button to select [Start],
then press the PLAY/OK button.
The display changes to [All Erase !] and erasing
will start.

[Erase Done] is displayed when the files are
erased. Any locked files in the folder will be
reassigned new file numbers in ascending
order.

029EXIT
/ 031
All Erase
File Erase
Cancel
EXIT

QP DICT
DS3400
E

/ 030
All Erase
Start
Cancel
BACK

All Erase !

QP DICT
DS3400
E

000 / 000
Erase Done

Notes
• The erasing process may take up to 10 seconds. Do not interrupt this process!
Data will be destroyed.
• Files cannot be erased in the following cases.
- File being set [Lock] (☞ P.40).
- The SD card lock is turned on (☞ P.8).
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Erasing
Partially Erasing a File

2
3
PLAY/OK

You can erase a selected file in part.

1
2

Start playback for the file you want to
erase partially.
Press the ERASE button at the point to
start erasing.

QP DICT
DS3400

45 M 02 s
01 H 55M 25s
INSERT

SPEED

2
Erasing

134 / 134

While playback continues, [Partial Erase] will
appear on the display.

INDEX

45 M 02 s
01H 55 M 23s
Partial Erase
EXIT

3

Press the ERASE button at the point
to end erasing.
The erase starting point (time) set in step 2 and
the ending point (time) set in this step will
alternate on the display for 8 seconds.
If you playback to the end of file or to the start
position of the Verbal comment (☞ P.46), that
will mark the end position for the partial erase
automatically.

QP DICT
DS3400

134 / 134
05 M 01 s
Partial Erase
Start
EXIT

QP DICT
DS3400

134 / 134
45 M 32 s
Partial Erase
End
EXIT
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Erasing

4

4

Press the ERASE button to confirm
erase.
The display changes to [Partial Erase!] and
erasing will start.

When [Erase Done] appears on the display,
partial erase is complete.

2

QP DICT

DS3400

134 / 134
1 H 20 M 35 s
Partial Erase !

QP DICT
DS3400

PLAY/OK

Erasing

134 / 134
1 H 20 M 35 s
Erase Done

Notes
• If the ERASE button is not pressed within 8 seconds after the “Partial Erase Start”
and “Partial Erase End” are alternately displayed, the recorder will revert to stop
status.
• An erased file cannot be restored.
• Files cannot be Partial erased in the following cases.
- File being set [Lock] (☞ P.40).
- Files that Verbal comment is being played back (☞ P.46).
- The SD card lock is turned on (☞ P.8).
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3 Advanced Operations
Menu List
● Menu Setting (while the recorder is stopped, press the F3(MENU) button
Main Menu

Second layer

Finished, Pending

P.41

Off, On

P.40

Work Type

Edit the Work Type and Option Item.

P.43

Information

The file information is displayed.

P.37

Rec Mode

QP, SP

P.24

Mic Sense

Dictation, Conference

P.23

VCVA

Off, On

P.25

Backlight

On, Off

P.49

Contrast

Program contrast level 01~12 (Default is 6).

P.51

On, Off

P.50

English, Deutsch, Français, Español,
Italiano, Русском

P.48

Pending

Display
Menu

LED
Language

3
Menu List

P.42

Lock

Record
Menu

Ref.Page

Cancel, Set

Priority
File Menu

Setting

Device Menu
(To the next page)
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Menu List
Main Menu

Device
Menu

3
Menu List

Second layer

Setting

Ref.Page

Beep

On, Off

P.52

Cue/Rev Sound

On, Off

P.53

Power Save

In order of 5 minutes, 10 minutes,
30 minutes, 1 hour and Off.

P.14

Time & Date

In order of hour, minute, year, month and
day.

P.17

Composite, Storage

P.57

Returns the menu settings to their initial
state.

P.55

Format

Initializes the card.

P.54

Card Info.

Remain, Capacity

P.9

Model Name, Version, Serial

P.56

USB Class
Reset Settings

System Info.

File Menu
(To the page 33)

Notes
• The selectable language varies depending on the countries where the product was purchased.
• Items appear in bold letters in the “Setting” column to indicate that they are the initial settings.
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Learning to Use the Menu
To navigate through the different options in the
Menu, use the Menu List flow chart (☞ P.33,
34) and the following steps to modify or
change any settings.

3

Press the PLAY/OK or 9 button.

4

Press the
or button to move to the
menu item to be set.

3

–,
BACK

5

EXIT

Press the PLAY/OK or 9 button.
Move to the setting of the selected item.
Rec Mode
QP
SP

1

Press the F3(MENU) button.
The [Main Menu] screen will appear on the
display (☞ P.33).
BACK

Main Menu
File Menu
Record Menu
Display Menu
Device Menu

EXIT

2

+

–

Press the
or
button to move to
[Main Menu] item to be set.
Main Menu
File Menu
Record Menu
Display Menu
Device Menu

EXIT

Learning to Use the Menu

PLAY/OK,+,
9, 0
button

+ –

Record Menu
Rec Mode
Mic Sense
VCVA

F1, F3 button

PLAY/OK

Move to the setting of the selected menu items.

+ or – button to change the

6

Press the
setting.

7

Press the PLAY/OK button to complete
the setup screen.

8

Press the F3 (EXIT ) or 0 button to
complete the setting.

If you press the 0 or F1(BACK) button, the
setting will be cancelled and it will return to the
menu.
Pressing the F3(EXIT) button will cancel the
contents being set and take you out of the MENU.

EXIT
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Selecting Folders and Files
Changing File
F1 button

PLAY/OK,+, – ,
9, 0
button

PLAY/OK

1

While the file is being displayed, press
the 9 or 0 button.
This will change and display the file number order
for files within the folder.

QP DICT VCVA
DS3400

a

001 / 010

C

b

00M 00 s
05 M 00s

3

FOLDER

Selecting Folders and Files

Changing Folders

1

While the recorder is stopped, press the
F1(FOLDER) button.
The folder list screen will be displayed.
QP DICT
A Folder A
B Folder B
C Folder C
D Folder D
E Folder E
FOLDER

PRIOR

MENU

Scroll bar
The scroll bar will appear when all of
the items cannot be displayed in the
menu or list display screen.
QP DICT
A Folder A
B Folder B
C Folder C
D Folder D
E Folder E
F Folder F

EXIT
FOLDER

2

+

–

Press the
or
button to select the
folder, then press the PLAY/OK button.
This will change the folder.
You can switch folders by pressing the
F1(FOLDER) button.
QP DICT
A Folder A
B Folder B
C Folder C
D Folder D
E Folder E
FOLDER
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aCurrent file number
bTotal number of
recorded files in the
folder

EXIT

EXIT

Displaying File Information (Information)
The recorder can display a variety of
information related to the current file.

The Displayed Information
The following information will be displayed.
[File Name]...File name
[Rec Time]...Time and date the file was
recorded.
[Author ID]...Display the Author ID of file.
[Work Type]...Display the Work Type ID of file.
[Option Item]...Display the Option Item which has
been set.

PLAY/OK
9 button

PLAY/OK

Note

1

Select the file whose information you
want to display.

2

Select [Information] at the [File Menu]
screen, then press the PLAY/OK or 9
button.

Refer to P.36 regarding file selection.

Displaying File Information

• When the file that Work Type or the Option Item is set
is transferred from PC to this unit, the information will
be displayed on the File Information.

3

The file information is displayed.
Refer to P.33 regarding each menu item settings.
File Menu
Priority
Pending
Lock
Work Type
Information
BACK

EXIT

Information
File Name
DS340006.DS2
Rec Time
03 M15 D 2009 Y 12:23 PM
Author ID
DS3400
BACK

EXIT
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Device Lock Function
Recorder access can be restricted by enabling
the device lock function. Authentication via
password can act as a safe guard for your
data even in case the recorder is lost or left
unattended.
Password registry can be performed by using
DSS Player (☞ P.59).

Unlocking the Recorder with a
Password

1

Select the numbers you want to enter
by pressing the , , 9 or 0 button
to move the cursor.

+–

Unlock Device
Enter Password

Entry column
F2 button

3
Device Lock Function

PLAY/OK

PLAY/OK, + ,
9, 0
button

Cursor

–,

2

Press the PLAY/OK button to select a
number.
A will appear in the selected first digit and the
blinking cursor will move to the next one over (to
the right). Repeat steps 1 and 2 to enter all four
digits.
Pressing the ERASE button at any time will erase
the last entry and move the cursor to the previous
entry (to the left).

*

Unlocking the Recorder

Unlock Device
Enter Password

When the password registry is done, the
recorder will prompt for password on startup.
Unlock Device
Enter Password

3
Unlock the recorder’s device lock through the
method below.
The default password when using the recorder
for the first time is “0000”.

After all four digits have been entered,
press the F2(ENTER) button.
If the 4 digit number entered matches the
registered password then the startup message
will appear and the recorder will start up.
Unlock Device
Enter Password

ENTER
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Device Lock Function
Authentication Halt Mode
If there is no password match after five
tries the recorder will enter password
input halt mode for ten minutes.
After ten minutes have passed the
mismatch history will be erased and it
will once again return to the password
input screen.
Unlock Device
Enter Password

09 : 59

3
Device Lock Function

Device is
Locked
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Locking Files (Lock)
When a file is set to [Lock],
will appear on
the display, allowing you to prevent important
files from accidental erase. Furthermore, the
file will not be erased even when all files within
a folder are erased.

3

Press the
or [Off].

+ or – button to select [On]

On...Locks the file and prevents it from
being erased.
appears on the display.
Off...Unlocks the file and allows it to be erased.
Lock

029 / 030

F1, F3 button
OnC
Off

3

PLAY/OK,+,
9, 0
button

Locking Files

PLAY/OK

1
2

BACK

–,

4

Select the file you want to Lock.

Press the PLAY/OK button to complete the
setup screen.
[File Lock On] or [File Lock Off] will light up on
the display, and it will return to the [File Menu]
screen.
If you press the 0 or F1(BACK) button the
setting will be cancelled and it will return to the
[File Menu].
Pressing the F3(EXIT) button will cancel the
contents being set and take you out of the MENU.
Lock

Select [Lock] at the [File Menu] screen, then
press the PLAY/OK or 9 button.

029 / 030

File Lock
On

Refer to P.33 regarding each menu item settings.
OnC
Off

File Menu
Priority
Pending
Lock
Work Type
Information
BACK

EXIT

BACK

EXIT

5

EXIT

Press the F3(EXIT ) or 0 button to
complete the setting.
QP CONF
DS3400
E

029 / 030
New File02 M

10 s

3 H 08 M 05s
FOLDER PRIOR
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MENU

Pending Files (Pending)
When you set [Pending] to the file, the file becomes
“Pending file” and the editing sign of will appear
on the display. If “Download file” is set to “Finished
file” by DSS Player, the [Pending] file is not
transferred and only [Finished] file (edited file) will
be transferred to your PC.
For details, see “Recording” in the “Customizing the
Recorder” (☞ P.58).

2

Press the + or – button to select
[Pending] or [Finished].
Pending...Sets to a file of “Editing” and
appears
on the display.
Finished...Sets to a file of “already edited”.
Pending

029 / 030
Pending
Finished
BACK

F1, F3 button

PLAY/OK,+,
9, 0
button

PLAY/OK

–,

Press the PLAY/OK button to complete
the setup screen.
[Pending Set] or [Finished Set] will light up on the
display, and it will return to the [File Menu] screen.
If you press the 0 or F1(BACK) button the setting
will be cancelled and it will return to the [File Menu].
Pressing the F3(EXIT) button will cancel the
contents being set and take you out of the MENU.

3
Pending Files

3

EXIT

Pending

1

029 / 030

Pending
Set

Select [Pending] at the [File Menu] screen,
then press the PLAY/OK or 9 button.

Finished

Refer to P.33 regarding each menu item settings.
BACK

File Menu
Priority
Pending
Lock
Work Type
Information
BACK

4

EXIT

Press the F3 (EXIT ) or 0 button to
complete the setting.
QP CONF
DS3400

EXIT

E

029 / 030
New File02 M

10 s

3 H 08 M 05s
FOLDER PRIOR

MENU

41

Setting Priority Levels (Priority)
By default, F2 button is programmed with
Priority function. The setting can also be
performed from the menu.
You can set a priority level on each file
recorded. You can choose between “HIGH”
and “NORMAL” The default is Normal level.

Performing the Setting from the Menu

1
2

Select [Priority] at the [File Menu]
screen, then press the PLAY/OK or 9
button.
File Menu
Priority
Pending
Lock
Work Type
Information

F2 button

3
Setting Priority Levels

PLAY/OK,+, – ,
9 button

PLAY/OK

Select the file which you would like to
set the Priority level for.

BACK

3

+

–

Press the
or button to select [Set]
or [Cancel], then press the PLAY/OK
button.
[Set]...High Level.
[Cancel]...Normal Level.

To Set a Priority Level on a File

Priority
E

To Set the F2(PRIOR) Button

1

Select the file you want to perform the
setting on, then press the F2(PRIOR)
button.
Each time the F2(PRIOR) button is pressed the
Priority level will change (HIGH/NORMAL). When
the HIGH level setting is selected, will appear
on the display.
Perform the setting in the same manner after
creating a New file.
a Priority indicator

QP DICT
DS3400

029 / 030
0 H 00M 00 s
15 H 22 M 40s
FOLDER PRIOR
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EXIT

MENU

a

029 / 030

Set
Cancel
BACK

EXIT

Setting the Author ID and Work Type
Every file recorded on the recorder will include
the Author ID and Work Type as part of its
header information. To create multiple Author
IDs and Work Types on the recorder, use the
bundled DSS Player software to create and
upload a Data list (list of Author IDs and Work
Types) to the recorder. For more details, refer
to the Online help for DSS Player (☞ P.63).
By default the Author ID is set to “DS3400”.

Setting an Author ID

1

Turn ON the recorder.

2

Press the
or
button to select the
Author ID that you want to assign to the
recorder from the ID list.

–,

–

Author List
ID 1

ID 2
ID 3

EXIT

ID10

3

Press the PLAY/OK button to set the ID.
When more than one Author ID exist on the
recorder, the ID list will be displayed.

3
Setting the Author ID and Work Type

PLAY/OK,+,
9, 0
button

+

Author ID
AUTHOR A
AUTHOR B
AUTHOR C
AUTHOR D
AUTHOR E
AUTHOR F

F1,F2,F3
button
PLAY/OK

When [Prompt for author ID at Power-on.] has
been set through DSS Player ( ☞P. 59), the
registered Author ID List will appear.

Note
• Up to 10 Author ID entries can be registered (up to a
maximum of 16 characters).
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Setting the Author ID and Work Type
Setting the Work Type

3

Editing the Work Type

Up to 10 Work Types can be registered in the
DSS Player software and uploaded to the
recorder. Each Work Type can have up to 10
Option Items associated with it. The Work
Types and Option Items can be used on the
recorder to populate the recording file header
information. Refer to the Online Help for DSS
Player (☞ P.63) regarding registration/set up
details and Option Item through DSS Player.

Setting the Author ID and Work Type

1

1
2

+

–

Press the
or
button to select a
Work Type from the Work Type list.
Work Type List

029/030
Work
W oEr k
Work
Work
Work
Work

Type1
Type2
Type3
Type4
Type5
Type6

Type 1

Type 2
Type 3

EXIT

Type 10

3

Press the PLAY/OK button to select the
Work Type.
The selected Work Type and a maximum of 10
Option Items registered for that Work Type will
be recorded in the New File header information.
When the item of Option Item Label within the
selected Work Type is possible to set for Value
input, it will take you to the file information input
screen (☞ P.45). For more details, refer to the
Online help for DSS Player (☞ P.63).

Select [Work Type] at the [File Menu]
screen, then press the PLAY/OK or 9
button.
029/030

File Menu
Priority
Pending
Lock
Work Type
Information

When [Prompt for Worktype ID on new
recordings.] has been set through DSS Player (☞
P.59), the Work Types uploaded to the recorder
will appear in a list.

2

Select the file you want to edit its Work
Type information (☞ P.36).

The Work Type setting screen will appear.

While the recorder is stopping mode,
press the NEW button.

SCAN
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The Work Type information of the recorded or
uploaded files can be edited with the menu
settings of the recorder (☞ P.33)

BACK

3
4

Work Type
Letter
Reference No
Subject
BACK

EXIT

EDIT

EXIT

Press the F2(EDIT) button.
The modification method confirmation screen will
appear.

+

–

Press the
or button to select [Edit
Work Type] or [Select From Work Type
List], then press the PLAY/OK button.
Edit Work Type...This will take you to the file
information input screen (☞ P.45) and allow you
to modify the Work Type information that has been
recorded for the file.
Select from Work Type List...You can re-select
Work Type from the Work Type list.
029/030
Work Type
E Work Type
Edit
MRI
Select From
1Work
2 3 4 Type
5678
901234
List
DEP
BACK

EXIT

Setting the Author ID and Work Type
– button...The Entry column changes from
lighting to flashing. The cursor is lit on the “0”
string within the keyboard Window, and makes
character selection available.

Inputting Option Item Value

1

+

–

Press the
or
button on the file
information input screen to select the
targeting Option Item, then press the
PLAY/OK button.

Entry is performed by insert entry. When the
character in the Entry column has already been
finalized, the character after the cursor will move
one column to the right.

The input screen will be displayed.
When inputting an Option Item value into a New
file or the file with a re-selected Work Type, only
eligible input characters as specified in the DSS
Player can be entered.
Reference No

029/030
Work Type
E
Letter
Reference No

01

E

● Cancelling the entered contents
Press the F1(BACK) button to select [Yes],
then press the PLAY/OK button during
entry...This will erase the entered contents for
this item and return you to the File information
input screen.

012
Subject
SCAN

FINISH

EXIT

File information
input screen

2

BACK

FINISH

EXIT

Option Item value
input screen

Press the F3(EXIT) button to select [Yes], then
press the PLAY/OK button during entry... This
will erase all of the finalized contents for the items,
and the recorder will return to stopped state in the
New file or the state before entering Menu settings.

Entering characters.
Enter characters through the following method.
● Character selection
+, –, 0, 9 button... Select the character
string (numbers, alphabets or symbols) displayed
in the Keyboard window to move the cursor up,
down, left and right by pressing.
● Character confirmation
PLAY/OK button... Use this button to confirm
your selection.

Reference No
a

b

01

0123456789#,-&
ABCDEFGHIJKLMN
OPQRSTUVWXZ_@
BACK

● Moving the entry column
When pressing the + button if the cursor is on top
of the Keyboard window, the cursor will disappear.
An Entry column within the input value display area
will change from flashing to lighting. The Entry
column can be moved when it is lit.
9 button... Each press of the button moves the
Entry column one space to the next (right). The
Entry column can be moved up to the space next
(right) to the last character.
0 button... Each press of the button moves the
Entry column one space to the previous (left). The
Entry column can be moved up to the first character.

3

c

E

FINISH

d

a Input value display area
b Keyboard window
c Entry column
d Cursor

3
Setting the Author ID and Work Type

● Maximum entered character count
The Option item value can be entered up to the
number of characters specified below. Preset
default values can also be set for the option items
to simplify data entry process.
Option Item Value... 20 characters

EXIT

Press the F2(FINISH) button.
The recorder will return to the File information
input screen.
When you create a New File and input a Work
Type, press the F2 (FINISH) button again in the
File information screen to get entered into the stop
state in the New File.
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Verbal Comment
The data recorded with the F1(VERBAL)
button being pressed during recording, is
recorded as a Verbal comment position (a
position within a file) in the header.
It is possible to instantly search and play back
Verbal comment sections through DSS Player,
thereby making it useful for things like giving
instructions to transcriptionists.

Locating a Verbal Comment

2

While playing back a file, press and hold
the 9 or 0 button.
The recorder stops for 1 second when it reaches
the Verbal Comment.
QP DICT
DS3400

029 / 030
10 M 56 s

3

22M 40 s

Verbal Comment

PLAY/OK, +,
9, 0
button

PLAY/OK

ERASE
button

Setting a Verbal Comment

1

While the recorder is recording mode,
press and hold the F1(VERBAL) button,
then release it when you want to stop.
Audio recorded while continuing to hold the
F1(VERBAL) button will be recorded as Verbal
Comment.
QP DICT
DS3400

029 / 030

E

F

10 M 56 s
22M 40 s
Verbal Comment

VERBAL

46

Verbal Comment

F1 button

DISPLY

INDEX

INSERT

SPEED

INDEX

Clearing an Verbal Comment

3
4

While playing a Verbal Comment, press
the ERASE button.

+

Press the
button to select [Clear],
then press the PLAY/OK button.
The Verbal Comment is erased.
QP DICT
DS3400

029 / 030
Verbal Comment
Clear
Cancel

Notes
• Up to 32 Verbal Comment can be set in a file.
• When a file is locked or set to read-only, or when the
SD card lock is enabled Verbal Comment cannot be
erased. Clear the settings before erasing.
• When the recorder has been set to DSS Classic mode
Verbal comments cannot be recorded.
For details, see “Recording” in the “Customizing the
Recorder” (☞ P.58).

Index Marks
Index marks can be placed in a file during
recording or playback. Index marks are used
to provide a quick and easy way to identify
important or significant parts within the file.

Locating an Index Mark

2

While playing back a file, press and hold
the 9 or 0 button.
The recorder stops for 1 second when it reaches
the Index mark.
QP DICT
DS3400

029 / 030

F3 button

3H 10 M 56 s
PLAY/OK

9, 0
button

Setting an Index Mark

1

While the recorder is recording or in
playback mode, press the F3 (INDEX)
button to set an Index mark.
An index number appears on the display.

SPEED

INSERT

INDEX

Clearing an Index Mark

3
4

Locate the Index mark you want to clear.

3
Index Marks

ERASE
button

22M 40 s
Index 01

While the index number appears for
approximately 2 seconds on the display,
press the ERASE button.
The Index mark is erased.
QP DICT
DS3400

029 / 030

QP DICT
DS3400

3H 10 M 56 s

029 / 030
3H 10 M 56 s
22M 40 s

22M 40 s
Index 01 Clear
INSERT

SPEED

INDEX

Index 01 Set
INSERT

SPEED

INDEX

Notes
• Up to 32 Index marks can be set in a file.
• When a file is locked or set to read-only, or when the
SD card lock is enabled Index mark cannot be erased.
Clear the settings before erasing.
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Language (Language)
You can select the display language for this
recorder.
The selectable language varies depending on
the countries where the product was
purchased.

2

PLAY/OK, +,
9, 0
button

PLAY/OK

Language

1

English...Displays in English.
Deutsch...Displays in German.
Français...Displays in French.
Español...Displays in Spanish.
Italiano...Displays in Italian.
Русском...Displays in Russian.
Language
English

F1, F3 button

3

Press the + or – button to set the language.

–,

BACK

3

Select [Language] at the [Display Menu]
screen, then press the PLAY/OK or 9
button.
Refer to P.33 regarding each menu item settings.

Press the PLAY/OK button to complete
the setup screen.
The displayed language is changed and will return
to the [Display Menu] screen.
If you press the 0 or F1(BACK) button the
setting will be cancelled and it will return to the
[Display Menu].
Pressing the F3(EXIT) button will cancel the
contents being set and take you out of the MENU.
Language
English

Display Menu
Backlight
Contrast
LED
Language
12

English
Set

BACK
BACK

EXIT

EXIT

4

EXIT

Press the F3(EXIT ) or 0 button to
complete the setting.

Note
• The selectable language varies depending on the
countries where the product was purchased.
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Backlight (Backlight)
When the display backlight is set to [On], the
backlight will light up for about 10 seconds
when a button is pressed.
This is useful in that it allows you to check the
display even in dark locations.

2

Press the
or [Off].

+ or – button to select [On]

On...Backlight is enabled.
Off...Backlight is disabled.
Backlight
On
Off

F1, F3 button
BACK

1

–,

3

Select [Backlight] at the [Display Menu]
screen, then press the PLAY/OK or 9
button.

Press the PLAY/OK button to complete
the setup screen.
[On Set] or [Off Set] will light up on the display, and
it will return to the [Display Menu] screen.
If you press the 0 or F1(BACK) button the
setting will be cancelled and it will return to the
[Display Menu].
Pressing the F3(EXIT) button will cancel the
contents being set and take you out of the MENU.
Backlight
On
Off

Refer to P.33 regarding each menu item settings.
Display Menu
Backlight
Contrast
LED
Language
12

BACK

BACK

EXIT

4

3
Backlight

PLAY/OK,+ ,
9, 0
button

PLAY/OK

EXIT

On
Set

EXIT

Press the F3 (EXIT ) or 0 button to
complete the setting.
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LED (LED)
You can set it so the Record indicator light does
not turn on.

2

Press the
or [Off].

+ or – button to select [On]

On...LED light will be set.
Off...LED light will be cancelled.
LED
On
Off

LED
(Record
indicator light)

BACK

3

3

F1, F3 button

LED
PLAY/OK,+,
9, 0
button

PLAY/OK

–,

[On Set] or [Off Set] will light up on the display, and
it will return to the [Display Menu] screen.
If you press the 0 or F1(BACK), the setting will
be cancelled and it will return to the [Display Menu].
Pressing the F3(EXIT) button will cancel the
contents being set and take you out of the MENU.
LED
On
Off

1

Select [LED] at the [Display Menu]
screen, then press the PLAY/OK or 9
button.
BACK

Refer to P.33 regarding each menu item settings.
Display Menu
Backlight
Contrast
LED
Language
12

BACK
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4
EXIT

EXIT

Press the PLAY/OK button to complete
the setup screen.

On
Set

EXIT

Press the F3(EXIT ) or 0 button to
complete the setting.

LCD Contrast Adjustment (Contrast)
Display contrast can be adjusted from level 01
to 12.

2

Press the + or
contrast level.

–

button to set the

You can adjust the LCD display contrast level from
01 to 12.
Contrast

F1, F3 button

PLAY/OK,+,
9, 0
button

PLAY/OK

+

–,

-

BACK

1

Select [Contrast] at the [Display Menu]
screen, then press the PLAY/OK or 9
button.

Press the PLAY/OK button to complete
the setup screen.
The set contrast level lights up and will return to
the [Display Menu] screen.
If you press the 0 or F1(BACK), the setting will
be cancelled and it will return to the [Display Menu].
Pressing the F3(EXIT) button will cancel the
contents being set and take you out of the MENU.
Contrast

Refer to P.33 regarding each menu item settings.

+

Display Menu
Backlight
Contrast
LED
Language
12

BACK

EXIT

Level 06
Set
-

BACK

EXIT

4

3
LCD Contrast Adjustment

3

Level
06

Level
06

EXIT

Press the F3 (EXIT ) or 0 button to
complete the setting.
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System Sounds (Beep)
When this is set to [On], the recorder beeps to
alert you to button operations or warn you of
errors.

2

System Sounds

PLAY/OK,+,
9, 0
button

PLAY/OK

1

Beep
On
Off

BACK

–,

3

Device Menu
Beep
Cue/Rev Sound
Power Save
Time
12 & Date
USB Class
Reset Settings
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Press the PLAY/OK button to complete
the setup screen.
[On Set] or [Off Set] will light up on the display, and
it will return to the [Device Menu] screen.

Beep
On
Off

Refer to P.34 regarding each menu item settings.

BACK

EXIT

EXIT

If you press the 0 or F1(BACK) button the setting
will be cancelled and it will return to the [Device Menu].
Pressing the F3(EXIT) button will cancel the
contents being set and take you out of the MENU.

Select [Beep] at the [Device Menu]
screen, then press the PLAY/OK or 9
button.

BACK

+ or – button to select [On]

On...System sounds are enabled.
Off...System sounds are disabled.

F1, F3 button

3

Press the
or [Off].

4

On
Set

EXIT

Press the F3(EXIT ) or 0 button to
complete the setting.

Cue/Rev Sound (Cue/Rev Sound)
The playback tone of Cue (Cue) operation and
Review (Rev) operation can be set to On or
Off (☞P.28).

2

PLAY/OK,+,
9, 0
button

Cue/Rev Sound
On
Off

BACK

–,

3

Select [Cue/Rev Sound] at the [Device
Menu] screen, then press the PLAY/OK
or 9 button.

Press the PLAY/OK button to complete
the setup screen.
[On Set] or [Off Set] will light up on the display, and
it will return to the [Device Menu] screen.
If you press the 0 or F1(BACK) button the setting
will be cancelled and it will return to the [Device Menu].
Pressing the F3(EXIT) button will cancel the
contents being set and take you out of the MENU.

Device Menu
Beep
Cue/Rev Sound
Power Save
Time & Date
USB Class
Reset Settings

BACK

EXIT

3

Cue/Rev Sound
On
Off
On
Set

Refer to P.34 regarding each menu item settings.

BACK

EXIT

Cue/Rev Sound

1

+ or – button to select [On]

On...The Cue(Cue)/Review(Rev) playback tone is On.
Off...The Cue(Cue)/Review(Rev) playback tone is Off.

F1, F3 button

PLAY/OK

Press the
or [Off].

4

EXIT

Press the F3 (EXIT ) or 0 button to
complete the setting.
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Formatting the Card (Format)
Cards that have been used in non-Olympus
devices, or cards that are not recognized by
the recorder, must be formatted before they
can be used with the recorder.
To familiarize yourself with the formatting
process, read the steps below.
The recorder ’s menu settings cannot be
initialized. The initialization of menu items
should be set up through DSS Player or the
recorder’s [Reset Settings].

1

Select [Device Menu] at the [Format]
screen, then press the PLAY/OK or 9
button.
Refer to P.34 regarding the menu’s various setting
items.
Device Menu
Cue/Rev Sound
Power Save
Time & Date
USB
12 Class
Reset Settings
Format

3

EXIT

BACK

Formatting the Card

2

Press the
option.

+ or – button to select [Start]

Format
Start
Cancel
PLAY/OK

PLAY/OK,
+, –, 9,
button
BACK

3

EXIT

Press the PLAY/OK button to confirm
[Start] selection.
Format

Data will be
cleared
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Formatting the Card (Format)

4

+ – button again to select

Press the
or
[Start] option.
Format
Are You Sure?
Start
Cancel

BACK

5

EXIT

Press the PLAY/OK button again to
initiate the formatting process.
Format

Format !

Format Done

[Format Done] displays when formatting ends.

3
Formatting the Card

Format

Notes
• The time required to format cards differs depending on
the capacity of cards. Do not interrupt the formatting
process by the following operations. Doing so will
damage the data or card.
- Remove the card.
- Remove the batteries.
• When the card is formatted, all the stored data, including
locked files, are erased.
• If an unformatted card is inserted, the recorder
automatically displays the format option in the menu.
• SD cards for which the SD card lock is enabled cannot
be initialized.
• Formatting on the recorder will be Quick Format. If you
format the card, information of file management is
refreshed and the data inside the card is not deleted
completely. When handing over and disposing the card,
be careful about the data leakage from the card. We
recommend the card to be destroyed when you dispose
the card.

Initializing the Recorder’s Menu
Settings (Reset Settings)
To return the recorder’s menu settings
to their original status from the time of
purchase (initial settings), perform the
setting from [Reset Settings] in the
[Device Menu], or perform the same
operation by using DSS Player.
Device Menu
Cue/Rev Sound
Power Save
Time & Date
USB Class
Reset Settings
Format
BACK

EXIT
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Check System Information (System Info.)
System information about the recorder like its
[Model Name], [Version] and [Serial] can be
displayed.
In this recorder, you can check the Card Information
(☞ P.9) and File Information (☞ P.37).

F1, F3 button

3
Check System Information

PLAY/OK,
9, 0
button

PLAY/OK

1

Select [System Info.] at the [Device Menu]
screen, then press the PLAY/OK or 9
button.
[Model Name] [Version] [Serial] will appear.
Refer to P.34 regarding each menu item settings.
System Info.
Model Name
DS-3400
Version
1.00
Serial
123456789

Device Menu
Time & Date
USB Class
Reset Settings
Format
12
Card info.
System Info.
BACK
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EXIT

BACK

EXIT

2
3

Press the PLAY/OK, 0 or F1 (BACK)
button.
Press the F3(EXIT ) or 0 button to
complete the setting.

Changing the USB Class (USB Class)
You can set the USB class of this recorder with
a USB connection to [Composite] or [Storage].
Set to [Composite] when using this recorder
as a USB speaker or a USB microphone.

2

Press the + or – button to select
[Composite] or [Storage].
Composite...In the 3 classes of Storage, USB audio
and human interface, USB connection is possible.
While USB connection in [composite], the recorder can
be used as the USB speaker and the USB microphone.
Storage...USB connection is possible in only
Storage class.

F1, F3 button

USB Class
Composite
Storage

3

–,
BACK

3
1

Select [USB Class] at the [Device Menu]
screen, then press the PLAY/OK or 9
button.

Press the PLAY/OK button to complete the
setup screen.
[Composite Set] or [Storage Set] will light up on
the display, and it will return to the [Device Menu]
screen.
If you press the 0 or F1(BACK) button the setting
will be cancelled and it will return to the [Device Menu].
Pressing the F3(EXIT) button will cancel the
contents being set and take you out of the MENU.

Refer to P.34 regarding each menu item settings.
Device Menu
Beep
Cue/Rev Sound
Power Save
Time & Date
USB Class
Reset Settings
BACK

EXIT

Changing the USB Class

PLAY/OK,+ ,
9, 0
button

PLAY/OK

USB Class
Composite
Storage
Composite
Set
EXIT
BACK

4

EXIT

Press the F3 (EXIT ) or 0 button to
complete the setting.
When this recorder is connected to the computer
for the first time after being changed to
“Remote(Composite)”, the driver will be installed
automatically to the computer.
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Customizing the Recorder
You can customize various specifications of the
recorder when using DSS Player (☞ P.59).
For more details, refer to the Online help for
DSS Player (☞ P.63).

The Recorder’s Customized Settings
Common Settings

3

You can set the default values for each of the
recorder ’s Menu items.

Administrative Settings

Customizing the Recorder

❏ General
Accessibility
You can perform various settings related to user
authorization, such as prohibiting both file erasure
and MENU settings.
Splash Message
You can set the contents that appear in the
message which is displayed during startup.
Main Button Guide
You can set the Main Button Guide. Main Button
Guide shows the Main Button status on the LCD
of the recorder.
Alarm
You can set occasions for the recorder’s alarm or
beep noise to sound.

❏ Display
• You can select a default pattern for display
during recording from 5 patterns.
• On the 2nd line of the LCD, you can display
File Name or Work Type instead of Author ID
which is currently displayed in the NEW, STOP,
REC, PLAY, CUE/REV, FF/REW or ERASE
mode.

❏ Device Security
You can perform various settings related to the
recorder’s device lock.
• Device lock function ON/OFF.
• Settings related to the timing for setting the
device lock.
• Password settings.
• Changing the number of allowable input errors
(mismatches) for the password.

❏ Author List
You can perform settings related to the Author,
such as Author registration.

❏ Work Type List
You can perform settings related to the Work Type,
such as Work Type registration.

❏ Device Folders
You can perform various settings related to the
recorder’s folders.
• Changing the number of folders and folder
name.
• Auto Lock setting which locks files recorded in
designated folders.
• Encryption Password setting which encrypts
files recorded in designated folders.
• Work Type settings for each folder.

❏ Recording
You can perform various settings related to the
recorder’s Dictation.
• Recording format (DSS Pro/DSS Classic)
selection.
• Recording mode (Overwrite/Append/Insert)
setting.
• Settings related to eligible files when
downloading to a PC (All files/Finished files).

❏ Programmable Buttons
You can change the allocated functions for the
Programmable Smart Buttons (F1, F2, F3
buttons).
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4 Managing Files on Your PC
DSS Player Software

Make sure that your computer meets the minimum requirements listed below. Please check
with your system administrator or your Olympus Professional Dealer.

4
DSS Player Software

The DSS Player is a fully featured software tool that provides a simple to use but sophisticated
method of managing your recordings. Some of the features of the DSS Player are:
• Automatic startup of the application by connecting the device.
• Automatic download of Dictation by connecting the device.
• Backs up downloaded Dictation (Windows only).
• Automatic transmission of downloaded Dictation to addresses specified through e-mail and
FTP (Windows only).
• Automatic transmission of transcribed documents through e-mail and FTP, as well as Dictation
and link management (Windows only).
• Voice recorder’s menu setting.
• Customize functions on the recorder (Windows only).
• Direct recording and editing of existing Dictation through Voice recorder’s button.
• Recording Instruction Comments and Verbal comments (Windows only).
• Encrypt the Dictation within the folder by encrypting the folder itself (Windows only).
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DSS Player Software
Minimum Requirement
Windows

4
DSS Player Software

Operating System:

Windows 2000 Professional Service Pack 4
Windows XP Home edition Service Pack 2,3
Windows XP Professional Service Pack 2,3 (32bit/64bit)
Windows Vista Home Basic, Service Pack 1 (32bit/64bit)
Windows Vista Home Premium, Service Pack 1 (32bit/64bit)
Windows Vista Business, Service Pack 1 (32bit/64bit)
Windows Vista Enterprise, Service Pack 1 (32bit/64bit)
Windows Vista Ultimate, Service Pack 1 (32bit/64bit)
Windows Server 2003 (32bit/64bit)

CPU:

Windows 2000/XP: Intel Pentium III 500MHz processor or more
Windows Vista: Intel Pentium III 800MHz processor or more
Windows Server 2003: Intel Pentium III 550MHz processor or more
Windows 2000/XP: 128MB or more (256MB or more recommended)
Windows Vista: 512MB or more (1GB or more recommended)
Windows Server 2003: 256MB or more

RAM:

Hard drive space:

Dictation Module: 70MB or more;
(700MB or more with Microsoft .NET Framework Version 2.0 not installed)

Drive:
Display:

CD or DVD drive

USB port:
Audio I/O terminals:

800 x 600 pixels or more, 65536 colors more (16.77 million colors or more
recommended)
With the Dictation Module: One or more free ports available
With the Dictation Module: A Microsoft WDM- or MME-compliant and
Windows-compatible sound device

Macintosh
Operating System:

Mac OS X 10.3.9 - 10.5

CPU:

Power PC G3 500MHz or more/Intel Core Sole/Duo 1.5GHz or more

RAM:
Hard drive space:

256MB or more (512MB or more is recommended)
200MB or more

Display:

1024 x 768 pixels or more, 32000 colors more

USB port:

One or more free ports

Notes
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• Macintosh version does not support voice recognition software.
• Currently supported OS are listed on our Web page. For the latest information, please visit the Olympus Web site at
http://www.olympus-global.com/en/global/.

Installing DSS Player Software
Be sure to confirm the following before installation:

• Exit all running applications.
• Eject the floppy disk/CD/DVD if you are using one.
• If you are running Windows 2000/XP/Vista or Mac OS X on the network, you need to log on
as an Administrator.
Windows

For the Windows version, there is an
installation method for individuals and one for
administrators to install on multiple client PCs.
An explanation of the installation method for
individuals installing the software on a single
PC will be provided here.
Insert Olympus DSS Player CD into the
CD-ROM drive.
The installation program will start automatically.
If the installation program does not start
automatically, browse your CD-ROM drive and
execute “launcher.exe”.

2

The launcher will startup.

3

The Install Wizard will begin.

4

Proceed with the installation according
to the instructions on the screen.

Select the language you would like to install from
the upper-left pull-down menu and click [DSS
Player Pro Installation].

1
2
3

Insert Olympus DSS Player CD into the
CD-ROM drive.

4
5

Proceed with the installation according
to the instructions on the screen.

Double-click the CD icon.

4
Double-click the setup icon.
The Install Wizard will begin.
Once you have consented to the licensing
agreement, follow the instructions on the screen
to complete the installation.

You will be requested to restart, so
conduct a restart by following the
instructions.

Installing DSS Player Software

1

Macintosh

Once you have consented to the licensing
agreement, enter your name, company name, and
license ID number (serial number).
The license ID number is printed on the license
ID card included inside the recorder package.

Select [Select basic settings for DSS Player
Wizard] by using [Individual User Settings].
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Uninstalling DSS Player Software
Windows

4
Uninstalling DSS Player Software
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1
2
3

Exit DSS Player program.

4
5

Select [Olympus DSS Player Pro], then
click the [Change/Remove] button.

Click the [start] button on the taskbar.

Select [Add/Remove programs] from the
[Control Panel].
A list of installed applications is displayed.

Macintosh

1
2

Exit DSS Player program.

3

Proceed with the uninstallation
according to the instructions on the
screen.

Double-click “DSS Uninstaller” in
[Application] = [DSS Player] folder.
An uninstaller is displayed.

Note
Proceed with the uninstallation
according to the instructions on the
screen.

• The dictation files you made are stored in the
[MESSAGE] folder. If you don’t need them, delete them.
You can confirm the location of the [MESSAGE] folder
by clicking on [Options] in the [Tools] menu before
uninstalling.

Using Online Help
For information on the DSS Player usage and features, refer to the Online help.
To start Online help:
Windows
Macintosh

1

Click the [start] button, then select [All
Programs], [Olympus DSS Player Pro],
[Dictation Module Help].

2

While DSS Player is running, select the
[Help] menu, [Contents].

Note
• Online help is available after the DSS Player is installed
(☞ P.61).

4
Using Online Help

3

While DSS Player is running, press F1
on the keyboard.

While DSS Player is running, select [DSS
Player Help] from the [Help] menu.
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Connecting Recorder to PC
Connecting to Your PC Using the USB Cable

1
2

Connect the USB cable to the USB port of the PC.
Confirm that the recorder has stopped and connect a USB
cable to the connection port on the recorder.
If [Remote] is displayed on the recorder, it indicates proper connections.

Once you connect the recorder to your PC, the recorder will be powered
through the USB cable.
While PC connection, the SD card is recognized as the respective
removable disk drive.

4
Connecting Recorder to PC

Disconnecting from Your PC
Windows

1

Click the
on the task bar located at the lower-right corner
of the screen. Click [Safely Remove Hardware].

2

Disconnect the USB cable.

The drive letter will differ depending on the PC being used.

1
Macintosh

1
2
64

Move the icon of the recorder's drive displayed on desktop to trash
box by drag and drop.
Disconnect the USB cable.

Connecting Recorder to PC
Notes
• NEVER remove the card or disconnect the USB cable while the record indicator light is flashing. If you do, the data on
the card will get destroyed.
• Some PC’s may not supply sufficient power and the recorder fails to connect. Refer to your PC User’s Manual regarding
the USB port on your PC.
• Do not connect the recorder to a PC by using a USB hub. Make sure to connect to a USB port on your PC.
• Make sure to push the cable connector all the way in. Otherwise, the recorder may not operate properly.
• This is an operational environment for saving the files recorded by this recorder to your PC with USB connection.
• Even if operational environment is satisfied, we do not support upgraded OS, the multi-boot environment or self-modified
computers.

4
Connecting Recorder to PC
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Running DSS Player Software
By default, connecting the recorder to your PC, will start the application automatically. Connect to
your PC Using the Cradle.
Windows

Disabling Automatic Start

1
4
Running DSS Player Software
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2

Right-click the Device Detector in the
System Tray in the lower right-hand
corner of the screen, then select
[Settings...].
Click [DSS Player Pro Dictation Module].
The check mark on [DSS Player Pro Dictation
Module] disappears.

Manual Start

1

Click the [start] button, then select [All
Programs].

2

Select [Olympus DSS Player Pro],
then click [Dictation Module].

All program menu will be displayed.

Macintosh

Disabling Automatic Start

1
2
3

Click the Dock’s System Preferences.
Click Device Detector.
Turn the automatic startup setting Off.

Manual Start

1

Double click the DSS Player icon for the
folder in [Application] = [DSS Player].

2

Register user information.

All program menu will be displayed.

The user’s registration screen will be displayed
at the time of initial startup. Please input the serial
number. Please see the seal attached to the CDROM package included with the DSS Player, for
the serial number. After the input has ended, click
[OK] to complete the registration.

5 Other Practical Use Methods
Using as External Memory of the Computer
When the recorder is connected to your PC, it will be recognized on your PC as a removable drive.
You can view and access the recorder card from My Computer and download data from the card to
your PC using standard windows copy/move and delete commands. You can also upload data from
the PC to the card in the recorder in the same way.

Example: Copying Data from PC to Card Using Explorer or Finder
Connecting the recorder to your PC.

3
4

Copy the data.

For connection procedure, refer to “Connecting to Your PC Using the USB Cable” (☞ P.64).

Open Windows Explorer or Finder window.
[Removable disk] is displayed.

While the data are being written or copied, the record/play indicator light on the recorder will flash.

Unplug the recorder from a computer.

Note
• NEVER remove the card or disconnect the USB cable while the record indicator lamp is flashing. If you do, the data on
the card will get destroyed.

5
Using as External Memory of the Computer
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6 Other Information
Alarm Message List
Message

Explanation

Action

Battery Low
File Protected
Index Full

Replace with new batteries (☞ P.12).
Unlock the file (☞ P.40).
Erase index marks that are no longer
required (☞ P.47).
Erase unnecessary files (☞ P.29).

Erase Error

Battery power is getting low.
Attempt to delete a locked file.
The file is full of index marks (maximum
of 32 marks).
The folder is full of files (maximum of 200
files).
The destination folder already has the
maximum number of files (200).
An error occurred while erasing.

Card Error

An incompatible card was inserted.

Unsupported
Card
Memory Full

The card cannot be used with this
recorder.
The card has no remaining memory.

Format Error
System Error

There was an error while formatting the
card.
System error detected in the recorder.

Insert Card

There is no card inserted.

Folder Full

6
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Erase unnecessary files (☞ P.29).
Erase once again.
When an Erase Error occurs format
the card
Insert a compatible card (☞ P.16).
Please remove the card.
Erase files that are no longer required
or insert another card.
Reformat the card (☞ P.54).
This is a malfunction. Contact the
place of purchase or Olympus
Service Center for repair.
Insert a card (☞ P.16).

Troubleshooting
Symptom

Probable cause

Action

Nothing appears
on the display

The
The
The
The
The
The

Verify polarity is correct (☞ P.12).
Replace with new batteries (☞ P.12).
Turn the recorder ON (☞ P.14).
Turn the recorder ON (☞ P.14).

Won’t start
Unable to record

No playback tone
heard
Unable to erase

Recording level
too low
Unable to set
index marks

Cannot find the
recorded file
Cannot connect
to a PC

The card is unformatted.
The maximum number of files has been
reached.
The SD card is locked.
The earphone is connected.
The volume level is set to 0.
The file is locked.
The SD card is locked.
The recorder was shaken during
recording.
The recorder was placed near a cell
phone or fluorescent lamp while
recording or during playback.
The microphone sensitivity is too low.

The maximum number of index marks
(32) has been reached.
The file is locked.
The SD card is locked.
Wrong folder.

Replace with new batteries (☞ P.12).
Erase unnecessary files or insert
another card (☞ P.16, 29).
Format the card (☞ P.54).
Check another folder.
Unlock the SD card lock (☞ P.8).
Unplug the earphones to use the
internal speaker.
Adjust the + (Volume) button.
Unlock the file (☞ P.40).
Unlock the SD card lock (☞ P.8).

Move the recorder.
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Noise heard
during playback

batteries are not loaded properly.
batteries are dead.
recorder is in power off mode.
recorder is in power off mode.
batteries are dead.
card does not have enough memory.

Set the microphone sensitivity to
Conference mode and try again (☞
P.23).
Erase unnecessary index marks
(☞ P.47).
Unlock the file (☞ P.40).
Unlock the SD card lock (☞ P.8).
Switch to the right folder.

Sometimes a connection cannot be made You need to change the PC’s USB
with some PCs running Windows XP or
settings. See DSS Player Online help
Vista.
for details (☞ P.63).
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Accessories
Headset: E62, E102
Stereo headset for your PC. A helpful tool for PC based transcription.
Monaural binaural earphone: E20
Noise-cancellation microphone: ME12 (Dictation microphone)
Used to get crisp recordings of your own voice by reducing the effects of ambient noise.
Recommended to improve the accuracy when using voice-recognition software.
External microphone: ME15
A lavalier omnidirectional microphone that clips to clothing. Used to record your own voice or
people near you.
Highly sensitive noise-cancellation monaural microphone: ME52W
This microphone is used to record sound at a distance while minimizing surrounding noise.
PC transcription kit: AS-5000
The AS-5000 transcription kit provides you with a PC-footswitch, a headset and DSS Player
Pro Transcription Module for easy transcription of DSS recordings.
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Connecting cord: KA333
Use to connect the microphone jack of this unit to a radio or other sound source.
Telephone pickup: TP7
Earphone type microphone can be plugged into your ear while phoning. The voice or
conversation over the phone can be clearly recorded.
Ni-MH rechargeable battery and charger set: BC400 (Europe only)
BC400 comes with an Ni-MH rechargeable battery charger (BU-400) and 4 Ni-MH rechargeable
batteries (BR401) as a pack. This charger can quick charge Olympus AA or AAA Ni-MH
rechargeable batteries.
Ni-MH rechargeable battery: BR401
High-efficiency rechargeable long life batteries.
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Specifications
Speaker
Built-in ø23mm round dynamic speaker
MIC/EAR jack
ø3.5 mm mini-jack, impedance
MIC 2 kΩ, EAR 8 Ω or more
Maximum working output (3 V DC)
250 mW or more (8 Ω speaker)
Input power requirement
Rated voltage: 5 V
Batteries: Two AAA batteries (LR03) or
Two OLYMPUS Ni-MH
rechargeable batteries
External dimensions
113.5 x 50.0 x 17 mm
(without protrusions)
Weight
105 g (Including alkaline batteries)
* Specifications and design are subject to
change without notice.
* Battery life is measured by Olympus. It
varies greatly according to the type of
batteries used and the conditions of use.

6
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Recording format
DS2 (Digital Speech Standard Pro)
Recording media
SD-card: 512 MB to 16 GB
Input level -70 dBv
Sampling frequency
QP mode: 16 kHz
SP mode: 12 kHz
Overall frequency response
QP mode: 200 to 7,000 Hz
SP mode: 200 to 5,000 Hz
Recording time (1 GB Card)
QP mode: 77 hours 00 minutes
SP mode: 157 hours 50 minutes
Alkaline battery life
Recording:
QP mode: Approx. 24 hours
SP mode: Approx. 30 hours
Playback:
All mode: Approx. 13 hours
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Technical Assistance and Support
DS-3400 is part of the Olympus Professional Dictation System. Your dealer is trained to
troubleshoot and fix many common problems that you may be having with this system. If you
encounter problems using your DS-3400, we recommend that you contact your Olympus
Professional Dealer that sold you the system. If your dealer cannot fix your problem, please call
our technical hotline number or send an E-mail.
◆ For customers in the U.S. and Canada
Phone: 1-888-553-4448
E-mail: distec@olympus.com
◆ For customers in Europe
E-mail : dss.support@olympus-europa.com

6
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For customers in Europe
“CE” mark indicates that this product complies with the European requirements for safety,
health, environment and customer protection.
This symbol [crossed-out wheeled bin Directive 2006/66/EC Annex II] indicates separate
collection of waste batteries in the EU countries.
Please do not throw the batteries into the domestic refuse. Please use the return and collection
systems available in your country for the disposal of the waste batteries.
This symbol [crossed-out wheeled bin WEEE Annex IV] indicates separate collection of waste
electrical and electronic equipment in the EU countries. Please do not throw the equipment
into the domestic refuse. Please use the return and collection systems available in your country
for the disposal of this product.
Applicable Product: DS-3400
L’indication “CE” signifie que ce produit est conforme aux exigences concernant la sécurité,
la santé, l’environnement et la protection du consommateur.
Ce symbole [Poubelle rayée conformément à la directive annexe 2006/66/EC annexe II] indique
que la collecte des batteries usagées se fait séparement dans les pays EU.
Veuillez ne pas jeter les batteries dans les ordures ménagères. Veuillez utiliser les systèmes
de collection disponibles dans votre pays pour l’enlèvement des batteries usagées.
Le symbole [poubelle sur roue barrée d’une croix WEEE annexe IV] indique une collecte séparée
des déchets d’équipements électriques et électroniques dans les pays de L’UE. Veuillez ne
pas jeter l’équipement dans les ordures domestiques. A utiliser pour la mise en rebut de ces
types d’équipements conformément aux systèmes de traitement et de collecte disponibles
dans votre pays.
Produit applicable: DS-3400
La marca “CE” indica que este producto cumple con los requisitos europeos en materia de
seguridad, salud, medio ambiente y protección al consumidor.
Este símbolo [Directiva 2006/66/EC Anexo II sobre contenedores] indica que se deben separar
las pilas usadas en los países de la UE.
Por favor no tire las pilas en la basura normal. Por favor utilice los sistemas de reciclaje que
existan en su país para tirar las pilas.
Este símbolo [un contenedor de basura tachado con una X en el Anexo IV de WEEE] indica
que la recogida de basura de equipos eléctricos y electrónicos deberá tratarse por separado
en los países de la Unión Europea. No tire este equipo a la basura doméstica. Para el desecho
de este tipo de equipos utilice los sistemas de devolución al vendedor y de recogida que se
encuentren disponibles.
Producto aplicable: DS-3400

For customers in North and South America
Declaration of Conformity
Model Number:
Trade Name:
Responsible Party:
Address:
Telephone Number:

DS-3400
DIGITAL VOICE RECORDER
OLYMPUS IMAGING AMERICA INC.
3500 Corporate Parkway, P.O. Box 610, Center Valley, PA 18034-0610,
U.S.A.
1-888-553-4448

This device Complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired operation.

Tested To Comply
With FCC Standards
FOR HOME OR OFFICE USE
Canadian RFI
This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus
as set out in the Radio Interference Regulations of the Canadian Department of Communications.
Cet appareil numérique ne dépasse pas les limites de Catégorie B pour les émissions de bruit radio
émanant d’appareils numériques, tel que prévu dans les Règlements sur l’Interférence Radio du
Département Canadien des Communications.
U1-BS0239-01
AP0812

